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 فریتگ ما یو خواندن/نوشتن رو نویبا آردو RC522ماژول  یآموزش راه انداز

 

 مقدمه

  identificationکه در مقدمه آن به بحث شناسایی هویت یا با آردوینو  FPM10Aپروژه راه اندازی اثر انگشت در ادامه

 RFid اهیم پرداخت. عبارتخو RFid پرداختیم ، در این پروژه به بررسی و راه اندازی یکی دیگر از راه های شناسایی هویت یعنی

در  RFid به معنای تعیین هویت در فرکانس رادیویی می باشد. از تکنولوژی radio-frequency identification مخفف

جنگ جهانی دوم برای شمارش هواپیماها در انگلستان استفاده می شد و بعد از آن در بسیاری از فروشگاه ها ، انبار ها ، سیستم 

کیلوهرتز تا  3نظیر مترو و اتوبوس مورد استفاده قرار گرفته است. هر چند که فرکانس رادیویی در محدوده  های حمل و نقل

 .مگاهرتز می باشد 53.11کیلوهرتز و  521پر کاربرد در دو فرکانس  RFid گیگاهرتز می باشد اما تکنولوژی های 333

 

https://electrovolt.ir/%d8%b1%d8%a7%d9%87-%d8%a7%d9%86%d8%af%d8%a7%d8%b2%db%8c-%d9%85%d8%a7%da%98%d9%88%d9%84-%d8%aa%d8%b4%d8%ae%db%8c%d8%b5-%d8%a7%d8%ab%d8%b1-%d8%a7%d9%86%da%af%d8%b4%d8%aa-fpm10a/
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RFid  چیست و چگونه کار می کند ؟ 

RFid یک تکنولوژی بدون سیم ( Wireless )  می باشد که از سیگنال های الکترونیکی و الکترومغناطیسی برای خواندن/نوشتن

که اطلاعات روی آن ذخیره  ( Tag ) د. در این تکنولوژی دو وسیله وجود دارد. یکی تگداده ها ، بدون تماس بهره گیری می کن

که وظیفه خواندن از تگ یا نوشتن روی تگ را بر عهده دارد. البته فقط برخی از  ( Reader ) می شود و دیگری تگ خوان

گفته می شود  ( Reader ) ه تگ خوان ریدرپشتیبانی می کنند به همین خاطر است که ب ( Write ) دستگاه ها از عمل نوشتن

نیز باشد. شکل زیر نحوه ارتباط میان این دو وسیله را نشان  ( Writer ) در حالی که در برخی از دستگاه ها می تواند تگ نویس

 .می دهد

 

ثابت  id در حقیقت زمانی که تگ نزدیک به ریدر می شود ، اطلاعات ذخیره شده در تگ توسط ریدر خوانده می شود. هر تگ یک

گفته می شود. این منحصر به فرد بودن باعث می شود که ریدر ، تگ ها را از  Unique id و منحصر به فردی دارد که به آن

متعلق به مثلا یک کالا یا یک انسان باشد میتوان آن ها را از یکدیگر تفکیک کرد. یکدیگر تشخیص دهد و در صورتی که تگ ها 

ریدر همچنین در برخی از دستگاهها قابلیت نوشتن اطلاعات به صورت محدود را دارد. تمامی این اطلاعات بدون سیم و در فاصله 

 .مشخصی رد و بدل می گردد

 

 Rfid ا ، معایب و کاربردهای تکنولوژیمزای

 : مزایای استفاده از این تکنولوژی به شرح زیر است

 ( یابد می افزایش های بدنی کاهش یافته و سرعت انجامها ) فعالیتکاهش هزینه .5
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 اتوماسیون ) تگ ها خودکار و بدون توقف خوانده می شود ( .2

 کاهش خطا در خواندن اطلاعات .3

 قابل رویت کنترل فرایندهای غیر .4

 ها بدون دخالت دستامکان به روز رسانی بر چسب .1

 امنیت .1

 یکپارچگی .7

 

 : همچنین معایب این تکنولوژی به شرح زیر است

 است ه آن شده ولی تدوین استاندارد در آمریکا شروع شدهنبود استاندارد معتبر که موجب عدم توسع. 

 های دیگر بیشتر استاندازی این سیستم در مقایسه با سیستمهزینه راه. 

 ها و فلزات تداخل ایجاد کندممکن است با سایر فرکانس. 

 هاهای فلزی در بعضی از برچسبهای مایع و حایلعدم شناسایی در محیط 

 افراد )می توان به طور غیرمحسوس حریم خصوصی افراد را کنترل کرد( تجاوز به حریم خصوصی 
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 : در شرکت ها و صنایع کاربرد بسیاری دارد، به عنوان مثال RFID همانطور که میدانید

 در اداره ها از RFID بعنوان کنترل رفت و آمد های کارکنان اداره استفاده می شود. 

 کالاهای خود از تگ ها روی لباس استفاده می کنند فروشندگان برای حفاظت هوشمند از خروج. 

 برخی از نهاد های دولتی برای نظارت و کنترل متخلفین از فناوری فوق استفاده می نمایند. 

 در کتابخانه ها برای کنترل پروسه تحویل کتاب و سرشماری کتاب های موجود از این فناوری استفاده می شود. 

 

از دیگر کاربرد تگ آر اف آیدی برای شناسایی مشخصات حیوانات خانگی مانند سگ ها را میتوان بر شمرد. این تگ ها که 

س در بدن این حیوانات تزریق می کنند تا در صورت مفقود شدن اطلاعات شناسنامه ای سگ ها را در آن ذخیره می کنند و سپ

این حیوانات با مراجعه به دامپزشک و با استفاده از دستگاه آر اف آیدی خوان بتوان مشخصات صاحب سگ را پیدا کرد. شکل زیر 

 .کوچک را در مقایسه با دانه برنج نشان می دهد RFid یک تگ
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 RFid  انواع تگ

ها بر روی اشیاء چسبانیده و یا متصل می شوند و بر حسب نوع کاربرد و مشخصات فنی دارای تنوع های الکترونیکی یا تگشناسه

ان سوئیچی آن ها را نشبسیاری بوده که بر همین اساس دارای اشکال مختلفی می باشند. شکل زیر دو نوع پر کاربرد کارتی و جا

چاپ شده است و این نشان دهنده آن است که این آی  Unique ID می دهد. همانطور که مشاهده می کنید روی این کارت ها

 .دی ثابت بوده و امکان تغییر آن نیست

 

داخل این تگ ها یک آنتن و یک چیپ وجود دارد که اگر جلوی نور قرار گیرند کاملا مشخص می شود. در ابتدا تگ غیر فعال 

است. اما زمانی که تگ به ریدر نزدیک می گردد ، ابتدا سیگنالی از طرف ریدر ارسال می شود که باعث شارژ شدن و انتقال انرژی 

تگ انرژی دریافت شده را صرف ارسال مجدد اطلاعات ذخیره شده در درون خود می کند و به محض دور به تگ می گردد. سپس 

 .شدن از ریدر ، مجددا غیر فعال می گردد
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 .قسیم بندی کرد. یک دیدگاه از نظر حافظه تگ ها و دیدگاه دوم از نظر تغذیه تگ ها می باشدتگ ها را از دو دیدگاه میتوان ت

 : ها وجود دارد از نظر حافظه تقسیم بندی زیر برای انواع تگ

 فقط خواندنی: یک شماره سریال ثابت و منحصر به فرد دارند که میتوان فقط آن را خواند. 

 ن بر روی آنها اطلاعات محدودی ذخیره کردبار می توابار نوشتنی: فقط یکیک. 

 خواندنی/ نوشتنی: قابلیت نوشتن و ویرایش اطلاعات را حتی تا یک میلیون بار دارند. 

 های دیگر را دارندمولتی فانکشن: علاوه بر داشتن قابلیت و ویرایش اطلاعات، قابلیت اتصال به سنسورها و یا تگ. 

ی باشند . نوع اول تگ هایی که در کارخانه سازنده تنها شماره سریال بر روی آنها ذخیره تگ های فقط خواندنی دارای دو نوع م

می شود و نوع دوم ، تگ هایی که حافظه محدود دارند و تنها یک بار می توان بر روی آنها ، اطلاعات یا شماره و ... را ذخیره نمود 

تگ ها است زیرا می باید اطلاعات حاصل از شناسایی در نرم افزار مربوطه  . نیاز این نوع تگ ها به نرم افزار بیشتر از سایر انواع

 . ذخیره شود

تگ های خواندنی / نوشتنی دارای سه نوع هستند نوع اول مربوط به تگ هایی است که به تعداد دفعات نامحدود می توان 

بیشتری در مقابل انواع فقط خواندنی دارند ولی از اطلاعات بر روی آنها ثبت و یا پاک کرد و البته حافظه ذخیره سازی اطلاعات 

میزان حافظه ذخیره سازی محدودی برخوردارند. نوع دوم از تگ های خواندنی / نوشتنی ، تگ هایی هستند که علاوه بر ثبت 

 یط محیطیتعداد دفعات نامحدود اطلاعات ، به سنسورهای مختلفی جهت ثبت خروجی آنها متصل شده و می توانند اطلاعات شرا

خود را نیز ثبت نمایند. نوع دیگر تگ های خواندنی / نوشتنی ، تگ هایی هستند که قابلیت ارتباط با تگ های مشابه خود را 

 .دارند و می تواند علاوه بر ارتباط با ردیاب ها ، با تگ های مشابه خود نیز تبادل اطلاعات نمایند

  

 : به شرح زیر استها از دیدگاه تغذیه ای  بندی دوم تگدسته

 فعال ( Active ) :  تگ های فعال دارای باطری هستند و از باطری جهت کارکرد ، تغذیه می شوند و ساختار پیچیده ایی

دارند. این تگ ها دایما از خود امواج ساطع می کنند و بیشتر در فرکانسهای بالا از آنها استفاده می شوند زیرا از 

 . ریافت می کنند و به مسافتهای طولانی تر امواج ارسال می کنندمسافتهای طولانی تر امواج د

 نیمه فعال ( Semi-Active یا Semi-Passive ) :  تگ های نیمه فعال نیز باطری دارند اما هنگامی که در محیط موثر

رار سط مورد استفاده قامواج ردیاب قرار گیرند ، شروع به انتشار امواج می نمایند و بیشتر برای کاربردهایی با فواصل متو

 .می گیرند
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 غیر فعال ( Passive ) :  تگ های غیر فعال نوعی دیگر از تگها می باشند که باطری ندارند و با استفاده از امواج ارسالی

 . از ردیاب شروع به کار می نمایند . امروزه این نوع از تگ ها بدلیل ارزان بودن و تنوع کاربرد ، فراوانی قابل توجهی دارند

 

  

RFid می تواند در حالت فعال (Active)  متر عمل نماید که این از لحاظ امنیتی تا حدودی  ۰۱۱در مسافت های طولانی مانند

امکان سرقت اطلاعات را فراهم می کند. راه هایی برای کاهش سرقت وجود دارد مثل رمزگذاری اطلاعات ارسالی اما باز هم این راه 

استفاده می  ( Near Field ) بیشتر در فواصل نزدیک RFid شد. به همین علت از تکنولوژی ها به مرور زمان نفوذپذیر خواهد

سانتی متر ( قرار گیرند تا بتوانند اطلاعات خود  53تا  3شود. چرا که تگ و ریدر معمولا باید در فاصله نزدیک از هم ) معمولا بین 

روی این موضوع تاکید  ( Near Field Communication مخفف ) NFC به نام RFid را رد و بدل کنند. تکنولوژی جدیدتر از

 و یا "تکنولوژی امن"محدوده ارتباطی در حدود چند سانتی متر است، به همین دلیل آن را  NFC کرده است. به طوری که در

"Safe Technology" می نامند. 

  

 

 کارت مایفر چیست ؟

که تحت این برند تولید می شوند ،  RFid می باشد و کارت های NXP نام برندی است که متعلق به کمپانی (Mifare) مایفر

و بدون تماس می باشد. این کارت ها دارای چیپ هایی با قابلیت خواندن و نوشتن و دخیره  RFID جزو خانواده کارت های

کیلوبایتی هستند که مناسب  4و  5وده و متداول ترین آن ها حافظه اطلاعات هستند. حافظه داخلی کارت های مایفر متنوع ب
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باشند. برخی از موارد استفاده کارت های مایفر عبارتند از دستگاه حضور و غیاب، جهت ذخیره اطلاعات مورد نیاز در کارت می

 … ی، باشگاه، سلف سرویس و، پارکینگ، قفل کارتی هتل، پاور سوئیچ یا کلید کارتAccess Contorolبلیت الکترونیکی، 

 

 : چیپ های درون کارت های مایفر دارای انواع مختلفی به شرح زیر می باشد

 Mifare classic 

 Mifare DESFire EV1 

 Mifare plus 

  Mifare ultralight 

 Mifare ultralight C 

 Mifare ultralight EV1 

از متداول ترین  mifare classic باشند. در بازار ایرانهای فوق دارای کاربردها و قابلیت های مختلف میز از چیپهر کدام ا

 باشد..امروزه شرکت های بسیاری در سرتاسر جهان چیپ هایمی ISO14443 ها بود که دارای استانداردکارت

COMPATIBLE با استاندارد ISO14443 ت های کارتتولید می کنند که قابلی mifare classic را داراست. 

  

 : ویژگی های کارت مایفر کلاسیک

  کیلو بایت 5و  4در دو نوع حافظه 

  بار ۰۱۱۱۱۱دارای حافظه قابل خواندن ونوشتن تا بیش از 
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 دارای ماژول امنیتی جهت مسدود کردن دسترسی های غیر مجاز به کارت. 

  ۰۱٫۶۵فرکانس کاریmhz 

  سانتی متری ۰۱تا فاصله قابلیت خواندن کارت 

  

 :برخی از موارد استفاده از کارت های مایفر

و کارت وفاداری،کارت شناسایی ، قفل کارتی هتل، پاور سوئیچ یا کلید  AFC بلیط الکترونیکی، کارت اتوبوس ،سیستم های

 … کارتی، کارت دسترسی ،کارت شهر بازی،کارت مترو و

  

 RFid انواع ریدر

قبلاً اشاره شد که ریدر ها وسایل الکترونیکی هستند که حضور تگ ها را در محیط تشخیص داده و اطلاعات ذخیره شده در آنها را 

محیط قرار داشت ، بر روی کنند. در ریدرهای اولیه تنها اطلاعات محدودی ارسال می شده و در صورتی که تگی در بازیابی می

تگ این اطلاعات ذخیره می شد اما امروزه با پیشرفت چشمگیر این تکنولوژی ، ریدرهای پیشرفته ایی ساخته و به بازار عرضه 

گشته که با تکنیک های خاصی اطلاعات اولیه را جهت شناسایی تگ های معتبر ، رمز گذاری نموده و بوسیله امواج ارسال می 

سیگنالهای دریافت شده از تگها را بررسی نموده و پیغام صحیح را انتخاب و اطلاعات را انتقال می دهند. این ریدر ها  نمایند سپس

 .باعث کاهش خطرات حملات امنیتی می گردد

 : ریدرها خود به سه دسته عمده زیر تقسیم بندی می گردند

 Fixed Type مدل ثابت .5

 Handheld Type مدل دستی .2

 PC Card Type مدل کارت .3
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 RFid معرفی انواع ماژول های

نمایش ، صفحه کلید و ... اما چیزی که  میتواند دارای انواع تجهیزاتی نظیر پرینتر ، پورت های ارتباطی ، صفحه RFid یک ریدر

نقش اصلی را در خواندن/نوشتن روی تگ ها بر  RFid درون یک ریدر اهمیت دارد ماژول به کار رفته در آن می باشد. یک ماژول

 : معروف عبارت است از RFid عهده دارد. برخی از ماژول های

 EM18 : ماژول RFid کیلوهرتز 521ای فرکانس بدون حافظه با قابلیت خواندن کارت ه 

 RF01D : ماژول RFid  کیلوهرتز 521دارای حافظه با قابلیت خواندن کارت های فرکانس 

 RC522 : ماژول RFid  مگاهرتز 53.11بدون حافظه با قابلیت خواندن/نوشتن انواع کارت های فرکانس 

 

  

 

 RC522 معرفی ماژول

 53.11می باشد که قادر است عمل خواندن/نوشتن را در فرکانس  NXP ساخت شرکت MFRC522 این ماژول ها دارای چیپ

 ولت ، قیمت کم ، اندازه کوچک ، آنتن 3.3با ولتاژ پایین مگاهرتز روی انواع تگ ها و کارت های مایفر انجام دهد. راه اندازی 

PCB روی بورد و رابط سریال SPI  424با قابلیت انتقال دو طرفه دیتا با سرعتkbit/s  این چیپ را برای دستگاه های هوشمند

می باشد. این ماژول می  دارای قابلیت استفاده آسان با انواع بوردهای آردوینو RC522 و قابل حمل مناسب ساخته است. ماژول

 .تواند بطور مستقیم در انواع مختلف ریدر به کار رود. ارتباط برقرار شده توسط این ماژول بسیار پایدار و قابل اطمینان است
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 از فروشگاه الکترو ولت  RC522لینک خرید مستقیم ماژول

 : ویژگی های این ماژول

 :3.3ولتاژV 

  : 21-53جریان مصرفیmA 

 جریان مصرفی در حالت standby :  53تا 53حدودmA 

 جریان مصرفی در حالت sleep :  03کمتر ازuA 

  :53.11فرکنس کاریMHz 

  : 13تا  3فاصله خواندنmm 

 دارای رابط SPI 

 سازگاری با آردوینو 

https://electrovolt.ir/product/%d9%85%d8%a7%da%98%d9%88%d9%84-rfid-rc522-%d8%a8%d8%a7-%d9%82%d8%a7%d8%a8%d9%84%db%8c%d8%aa-%d8%ae%d9%88%d8%a7%d9%86%d8%af%d9%86-%d9%86%d9%88%d8%b4%d8%aa%d9%86-%d8%aa%da%af/
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 : پایه های این ماژول

 .پایه به صورت شکل زیر می باشد ۸دارای  RC522 ماژول

 

  

 با آردوینو RC522 ولراه اندازی ماژ

 .نیاز دارید که میتوانید از فروشگاه الکترو ولت آن را تهیه نمایید Arduino UNO برای راه اندازی این ماژول با آردوینو به یک

 : نحوه اتصال به آردوینو

 

https://electrovolt.ir/product-tag/uno/
https://electrovolt.ir/product-tag/uno/
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 .یک سر ماده ) شکل زیر ( استفاده کنید -جهت اتصال راحت تر میتوانید از کابل های یک سر نر 

 

 

 RC522 نحوه دانلود و نصب کتابخانه ماژول

پس نصب نمایید. توجه نمایید دانلود و س این لینک << را از طریق  Arduino IDEبرای راه اندازی این ماژول ابتدا باید نرم افزار

می باشد. پس از دانلود و نصب نرم افزار آردوینو ، آن را  5.1.1سیستم تست شده در هنگام نوشتن این آموزش  IDE که نسخه

 ( کلیک کنید ) شکل زیر Manage Libraries روی ( Sketch -> Include Library ) باز کرده و سپس از مسیر

 

https://www.arduino.cc/download_handler.php?f=/arduino-1.6.9-windows.zip
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را جستجو نمایید و سپس  rc522 باز می شود. در این پنجره در قسمت جستجو ، عبارت Library Manager پنجره ای با نام

 .را بزنید. کتابخانه ماژول بعد از مدتی دانلود و نصب می شود Install زینهروی کتابخانه مربوطه کلیک کرده و گ

 

  

مراجعه نمایید ، مشاهده می کنید پوشه ای در کامپیوتر خود  ( Documents -> Arduino -> libraries ) حال اگر به مسیر

اضافه شده است. درون این پوشه کلیه فایل های مورد نیاز از قبیل فایل های کتابخانه ای ، داکیومنت های  MFRC522 با نام

 .توضیحات و مثال های مورد نیاز نوشته شده است
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 Examples From Custom برویم ، در قسمت ( File -> Examples ) حالا اگر درون نرم افزار آردوینو به مسیر

Libraries پوشه ای به نام MFRC522 ا را مشاهده خواهید کرد که با بازکردن آن کلیه مثال های دانلود شده همراه کتابخانه ر

 <- Documents -> Arduino -> libraries ) مشاهده خواهید کرد. این مثال ها همان مثال هایی است که در مسیر

MFRC522  )  روی کامپیوتر وجود دارد. 
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مثال در این قسمت مشاهده می شود که در ادامه به توضیحات هر یک خواهیم  51همانطور که مشاهده می کنید ، به تعداد 

 : اختپرد

5. AccessControl : این برنامه یک سیستم کامل برای کنترل درب منازل می باشد. 

2. ChangeUID : این برنامه میتواند آی دی منحصر به فرد ( Unique ID )  را در کارت های مایفری که این قابلیت را

 .دارند ، تغییر دهد

3. DumpInfo : این برنامه کلیه محتویات یک تگ RFid زدیک شدن خوانده و نمایش می دهدرا به محض ن. 

4. firmware_check : این برنامه ورژن نرم افزاری چیپ MFRC522 موجود روی ماژول RFid را چک می کند. 

1. FixBreakedUID : این برنامه آی دی منحصر به فرد ( UID ) را در کارت های مایفری که قابلیت تغییر UID  را دارند

 .، ریست می کند

1. MifareClassicValueBlock : در این برنامه مقادیر مختلفی درون بلوک ها با کلید های A و B  ذخیره و سپس

 .نمایش داده می شود

7. MinimalInterrupt : این برنامه پایه IRQ ماژول را به منظور فعال شده وقفه در هنگام خواندن UID  تگ ها ، به

 .صورت لبه پایین رونده ، فعال می کند

0. Ntag216_AUTH :  در حالت عادی ارسال/دریافت دیتا به صورت کشف می باشد ) یعنی هیچ رمزی روی دیتا صورت

گذاشت و  ( Password ) نمی گیرد ( در نتیجه امنیت دستگاه پایین می رود. توسط این برنامه میتوان روی دیتا رمز

 .باعث افزایش امنیت دستگاه شد

1. ReadAndWrite :  تگ مایفر دیتا را ذخیره کرده و سپس خواند و از صحت ریختن توسط این برنامه میتوان روی

 .مطمئن شد

53. ReadNUID : این برنامه میتواند NUID ( یعنی آی دی غیر منحصر به فرد یا Non-Unique ID )  مربوط به تگ ها

 .ندخوانده شود ، آن را شناسایی می ک NUID را خوانده و ذخیره نماید و در صورتی که مجددا تگی با همان

55. ReadUidMultiReader : این برنامه برای خواندن UID در زمانی است که از چندین ماژول RC522  روی یک

 .استفاده شده باشد SPI پورت

52. RFID-Cloner :  این برنامه میتواند دیتای موجود در یک تگ را خوانده و در خود ذخیره کند و سپس این دیتا را روی

 .تگ دیگری کپی نماید

53. rfid_default_keys : این برنامه با سرعت بالایی UID تگ های مختلف را خوانده و در سریال مانیتور چاپ می کند. 
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54. rfid_read_personal_data : در این برنامه میتوان UID  و نیز نام و نام خانوادگی ذخیره شده درون تگ را در

 .سریال مانیتور نمایش داد

51. rfid_write_personal_data : رنامه میتوان یک نام و نام خانوادگی درون تگ ذخیره کرددر این ب. 

  

توجه : برای استفاده از برنامه ها در نرم افزار آردوینو ، پس از کلیک کردن روی نام هر برنامه و باز شدن آن ها در پنجره جدید ، 

باشد. سپس در صفحه  UNO را چک کنید که حتما روی ( Tools -> Board -> Arduino/Genuino UNO ) ابتدا مسیر

 Serial گزینه Tools را بزنید تا برنامه درون بورد آدوینو ریخته شود. سپس از منوی Upload اصلی نرم افزار گزینه

Monitor  را بزنید. صفحه جدید به نام سریال مانیتور باز می شود که از طریق آن میتوانید با ماژول ارتباط برقرار نمایید و

 .شده را نیز ببینیددیتاهای دریافت 

 

 : توسط الکترو ولت DumbInfo تست برنامه

بعد از آپلود کردن این برنامه روی بورد آردوینو و سپس باز کردن سریال مانیتور ، ورژن نرم افزاری ماژول نمایش داده می شود. 

تگ ، برنامه شروع به خواندن و نمایش کلیه اطلاعات سپس برنامه از ما می خواهد تا تگی را نزدیک نماییم. با نزدیک کردن 

 .ذخیره شده درون تگ را می کند. شکل زیر کلیه دیتا ها را نشان می دهد

 



 ElectroVolt.irالکترو ولت 

18 
  



 ElectroVolt.irالکترو ولت 

19 
 

 : نکاتی که باید توجه شود عبارت است از

 همانطور که مشاهده می کنید در ابتدا پارامتر UID  که آی دی منحصر به فرد هر تگ است ، نمایش داده شده است. در

 .ذخیره می شود 3و بلوک  3حقیقت این آی دی در سکتور 

 SAK  یا Select Acknowledge  پارامتر بعدی است که نمایش داده شده است. مقدار این پارامتر برای تگ های مایفر

 .را بخوانید NXP از شرکت AN10833 می باشد. برای کسب اطلاعات بیشتر در مورد این پارامتر 30کیلو بایتی برابر  5

 پارامتر سوم PICC Type یعنی نوع PICC می باشد. PICC به Proximity Integrated Circuit (“Contactless 

Card”) یعنی تگ های RFid بدون تماس اشاره دارد. 

  بعدی سکتور ها و بلوک های موجود در کارت خوانده شده و نمایش داده می شود. توجه نمایید که خواندن در خطوط

و اگر قبل از پایان خواندن تگ را از جلوی ریدر  ( 5KBبرای کارت مایفر  ) ثانیه طول می کشد 1همه دیتا ها حدود 

 .می دهد Timeout پیغام خارج کنید ، به صورت کامل همه سکتور ها نمایش داده نمی شود و

  بایت وجود دارد. در کل به تعداد  51بلوک می شود و در هر بلوک  4همانطور که مشاهده می کنید هر سکتور شامل

بایت  51×14=5324بلوک در کل وجود دارد. در نتیجه در کل به تعداد :  14سکتور وجود دارد و این یعنی در کل  51

 .وبایت می باشد. شکل زیر کلیه سکتور ها و بلوک ها را نشان می دهدکیل 5دیتا وجود دارد که معادل 
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 : توسط الکترو ولت ReadNUID تست برنامه

 

  

 را خوانده و پیغام ( UID ) و نیز آی دی منحصر به فرد تگ ( PICC Type ) همانطور که مشاهده می کنید دفعه اول نوع کارت

A new card has been detected  را نمایش می دهد. در دفعات بعدی که تگ نزدیک ریدر می شود ، تنها نوع کارت را

 .را نشان می دهد Card read previously شناسایی کرده و سپس پیغام
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 : توسط الکترو ولت ReadAndWrite تست برنامه

 

  

ریخته می شود. سپس  4خوانده شده است و سپس دیتایی درون بلوک  5ر همانطور که مشاهده می کنید ، ابتدا دیتای سکتو

 خوانده می شود و دیتای خوانده شده با دیتای اصلی مقایسه می گردد. در صورت تطبیق این دو دیتا پیغام 4مجدد بلوک 
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Success  می کنید ، دیتا به درستی خوانده می شود. همانطور که مشاهده  5نمایش داده می شود. در نهایت نیز مجددا سکتور

 .قرار گرفته است 4درون بلوک 

  

 

 : توسط الکترو ولت rfid_write_personal_data تست برنامه

 

  

آن را نشان می دهد و سپس از کاربر می خواهد تا یک نام خانوادگی به  Type و UID در این برنامه با نزدیک کردن تگ ، ابتدا

در قسمت بالایی سریال مانیتور تایپ و  #در آخر آن ارسال نماید. در این حالت باید یک نام دلخواه به همراه  #همراه کاراکتر 

که نباید تگ را تکان دهید یا از روی ریدر بردارید. سپس در صورت موفقیت آمیز بودن ، مجددا  شود. توجه نمایید Send سپس

 .وارد کردم Davodi و نام خانوادگی را hosein می خواهد تا نام را وارد کنید. من در این برنامه نام را
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 : توسط الکترو ولت rfid_read_personal_data تست برنامه

 

 .همانطور که مشاهده می کنید ، نام و نام خانوادگی که در برنامه قبل ذخیره شده بود در اینجا نشان داده شده است 

 


